Outlaws Troubleshooting Guide





This troubleshooting guide has been included on the Outlaws Demo to provide you with information about the game, and to inform you of solutions to common problems that were encountered during the testing phase.
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General Information





Minimum Requirements


Operating System: Windows 95 required.


CPU:  Pentium 60 or faster required.


Memory:  16MB RAM required.


CD-ROM:  2X CD-ROM required. 4X CD-ROM or above recommended.


Graphics Card: SVGA graphics card required


Sound Card: 16-bit sound card required.


Input Device: Keyboard and mouse required.  Joystick and DirectInput™ compatible devices also supported.


DirectX:  CD includes necessary Microsoft™ DirectX™ drivers.


Installation:  Standard Installation (requires 73MB free hard drive space)


	Full Installation (requires 131MB free hard drive space)





Operating Systems Supported


To be able to run Outlaws, you must have Windows 95 as your primary operating system.  If you have a different OS (such as OS/2 or Windows NT) we cannot guarantee compatibility.








�
DirectX 3.0a





First let's give you a little background on Windows 95 DirectX.  Windows 95 Game SDK, which means Software Developers Kit, uses a program known as DirectX which will write directly to your video, sound, and input hardware.  This allows games to shoot desperadoes faster and hear their taunts better than ever before.  Unfortunately, not all hardware is supported by DirectX.  





Please see the information that comes with DirectX for instructions on installing DirectX.





DirectX Certification


Look at the lines that describe your hardware in DirectX setup.  If they say “Certified” on the right hand side of the window, then your drivers are DirectX certified and the game should run fine.  If they have only the version numbers with nothing after that or a blank line, then they are supported, but not yet certified by Microsoft and may have problems.  If they say “No hardware support," then your drivers are not supported, and you may experience problems when playing the game.





If you see “No Hardware Support” listed after any of the components, you will need to update the appropriate driver so that your system is fully DirectX certified.  The manufacturer of your system should be able to provide you with instructions for updating your drivers, and provide you with more information regarding DirectX certification.





Note: Some programs that were made for earlier versions of DirectX may not work with this version.





Technical Overview of DirectX


The DirectX platform provides an environment that allows developers to use a standardized format when programming a game, thus making it accessible to a wide variety of different hardware configurations.  Prior to DirectX, developers were forced to write hardware-specific code (with a specific driver for each different piece of hardware).  The DirectX platform is an Application Programming Interface (or API) that contains many different components.  These include:





DirectPlay:	An API designed to enhance multiplayer gaming over various online services as well as the Internet.





DirectInput:	Provides advanced support for both analog and digital control devices within the Windows 95 environment.





DirectSound:	Provides your sound card with audio drivers that make DirectSound less CPU intensive, which helps to enhance normal/high quality sound and music, and allows for optimal performance of 3-D positional audio.  





DirectDraw:	Provides support for 2-D rendering of graphics.





Since DirectX is relatively new in the computer world, we have found that some older systems may contain hardware that may not be fully DirectX compatible.  For optimum performance in Outlaws, your system must fully support DirectX.  Luckily, many manufacturers are releasing updated drivers.  If you are unsure whether or not your system will support DirectX, please contact the manufacturer of your system for further information.








Performance Issues





If you are running Outlaws on a Pentium 60 to 90, here are a few things that will enhance the game’s performance:





Playing Outlaws in Low Resolution


You may want to play Outlaws in low resolution.  To do this: 


Double click on the OLCFG file in the directory where you installed the Outlaws demo.


Click on Display Configuration at the top of this window.


Click on either 320x200 or 320x240 under Available Modes.


Click OK to exit the Outlaws Configuration Screen.





Disabling Your Joystick


You may want to disable your joystick.  To do this:


Press ESC.


Choose Configure.


Choose Joystick.


Click on the checkbox next to Active to deselect this option.


Click on Accept to save your changes.





Adjusting Your Screen Size


You may want to adjust your screen size in the game:


For better performance, you can shrink your screen size down by using the +/- keys.





Turning Tinting Off


You may want to turn tinting off.  To do this:


Press ESC.


Choose Configure.


Choose Other Controls.


Deselect Tinting.


Click on Accept to return to the previous menu.





Memory Managers 


If you have memory managers such as EMM386.EXE loading in your CONFIG.SYS file on your hard-drive, you may experience problems when running Outlaws. Both Outlaws and Windows 95 are protected mode programs and may have problems running with this memory manager loaded.  We do not recommend making any changes to your system.  Please consult your computer manufacturer about changing these lines.





Running Programs


Generally, we have found that it is a good idea not to have any other programs running while playing Outlaws. Various video, sound, or memory problems may occur while other programs, including screen savers and virus-detection utilities, are running.








General Troubleshooting





Outlaws is designed to run under Windows 95 with DirectX 3.0a.  If the game unexpectedly freezes up, returns you to your desktop, or if you experience any other severe problems, you should immediately reboot your computer.  This will help to prevent possible problems related to the game crash.  It is especially important to reboot your computer before trying any of the troubleshooting tips or before attempting to restart the game.





If Your Computer goes to a Black Screen or Locks Up


If you end up at a black screen, please press ESC, SPACE BAR, or ENTER before trying anything else.  If this fails, press CTRL-ALT-DEL and choose END TASK on Outlaws, which will take you back to the desktop. Then restart your computer and try running the game again. While playing Outlaws, we suggest that you do not use CTRL-ALT-DEL, as this may cause your game to stop responding or freeze up with a looping sound playing.





Memory Managers 


If you have memory managers such as EMM386.EXE loading in your CONFIG.SYS file on your hard-drive, you may experience problems when running Outlaws. Both Outlaws and Windows 95 are protected mode programs and may have problems running with this memory manager loaded.  We do not recommend making any changes to your system.  Please consult your computer manufacturer about changing these lines.





Running Programs


Generally, we have found that it is a good idea not to have any other programs running while playing Outlaws. Various video, sound, or memory problems may occur while other programs, including screen savers and virus-detection utilities, are running. Please turn off any active screen savers while playing Outlaws.  If they are active, they may interrupt the game, which may cause problems to occur.





Adjusting Brightness in the Game


If your screen is too dark, please go to the Options menu and adjust the Gamma.





Scrunched Screen in Windows 95


If you just stopped playing Outlaws and, after you've returned to your Windows 95 desktop, you find that it has been scrunched together with no Start Menu in sight, try this:


Right click on the desktop


Choose Properties


Choose Settings


Change your Color Palette to high color (16-bit) and Desktop Area to 640x480.


Your computer will then prompt you to restart and everything should be fine.





Saved Games


Please be sure to specify a name when saving the game.  If you do not give a name for your saved game, Outlaws may accidentally save over the previous saved game, or may not save at all.  Please use only letters and numbers in your saved game names.  Other characters may cause trouble.





Power Management


If your computer is equipped with a Power Management Feature, you may want to disable it while playing as the monitor may go to sleep while you are playing.  Please consult your computer’s documentation or the manufacturer for assistance in doing this.





Icons on Taskbar


Occasionally the icons on your taskbar may turn black.  This is an issue with the way that Windows 95 uses its color palette. Outlaws and Windows 95 both use 256 colors.





Computer and Software Compatibility Issues


IBM Aptiva Model #2144M51


We experienced difficulties when testing Outlaws on this computer. We have found one or more pieces of the default system hardware are not DirectX compatible.  You may want to contact IBM for more information, or to see if they have released updated drivers that will allow your system to be compatible with DirectX.





Microsoft Office™


If you are using Microsoft Office™ and are using their Toolbar, we recommend that you turn it off while playing Outlaws.  When you restart your computer it will be turned on again. This also applies to any other programs that use a toolbar that stays on your desktop.





NEC Ready 9022


The Alliance ProMotion 6422 video card is not DirectX certified. You may not be able to run Outlaws using the DirectX drivers. 





Packard Bell 


Some new Packard Bell systems are shipping with S3 ViRGE drivers that are not DX3 supported.  If you choose “S3 ViRGE PCI,” you will only get software emulation.  They have new drivers (“S3 Inc. ViRGE PCI”) available. The version of this driver that is shipped on the machine will not work correctly with DirectX 3.0a. Packard Bell’s web address is http://www.packardbell.com.  S3’s address is http://www.s3.com.





Toshiba Infinia 7130


You may experience loud music volume.  If this happens, first turn all of the volume sliders up in the game. Then adjust the volume on the speakers to turn down the music.  This should correct the problem.








Video Issues





DirectX Compatibility


Consult the DirectX section of this Troubleshooting Guide for information about how to check to see if your video card is DirectX compatible.  If it is not, check with your hardware manufacturer for updated drivers.





Video Card Support for DirectX


It has been found that if your video card is not supported under DirectX, these video problems may occur:


DirectX may change your existing video driver to an inappropriate driver.


Black Screen: Your screen may go black but the sound and music will continue to play. 


Corrupted Graphics: You might see horizontal or diagonal lines all over the screen.


Strange Colors: Your screen colors might look strange.


Slow Graphics: The gameplay may be slow.


Double Vision: Have you ever worn 3D glasses that didn't work quite right?


Your game may freeze when exiting Outlaws.





�
On some video cards such as the Genoa Phantom 64, Diamond Stealth 64 2001, or the Trident TGUI9680/TGUI9682, which are DirectX supported, you may see the following in the Options Menu:


There may be graphic static.


There may be flickering.


There may be horizontal lines of graphic corruption.


This does not affect gameplay and we have found no fix for it at this time.





Setting up your monitor


If you experience any video problems or are not able to get all of the resolutions that your video card supports, you should make sure that your monitor is set up correctly in the display control panel.


Right-click on the desktop.


Choose Properties from the pop-down menu.


Click on the Settings tab.


Click on Change Display Type…


Click on Change… in the Monitor Type section.


Choose your monitor from the list.


If the correct monitor is not an option in Show Compatible Devices, click on Show All Devices, scroll through the list of manufacturers, click on the correct one, then click on the name of your monitor.





Video Corruption in Low Resolution Mode


On certain systems, you may experience video corruption when playing in Low-resolution.  The corruption will usually appear as a horizontal line flashing randomly across the screen.





The problem can usually be avoided by turning off the TINTING option.  To do this:


Press ESC


Choose Options from the menu.


Select Other Options.


Disable Tinting by clicking on check box to deselect this option.  


Click on Accept to save your changes.





Using ALT-TAB when Playing Outlaws in Low-Resolution 


Some video cards do not correctly restore the desktop resolution to its original state when switching away for the game. 








Specific Video Card Issues





DirectX may not certify the video driver when it is set to the video card, but will be certified and will work fine if the card is set to its chipset.  To manually set your video card to the correct chipset:


Right-click anywhere on the desktop.


Choose Properties from the pop-down menu.


Click on the Settings tab.


Click on Change Display Type…


Click on Change… in the Adapter Type section.


Choose your original video card from the list.


If the correct chipset is not an option in Show Compatible Devices, click on Show All Devices, scroll through the list of Manufacturers, click on the correct one, then click on the name of your chipset.


When your computer prompts you to restart, click on Yes.





ATI 3D Pro Turbo PC2TV: We have found that DirectX will change this card to the ATI Graphics Pro Turbo.  You will need to change your card back to its original driver for Outlaws to run.  See the directions above to change your driver. ATI’s web address is http://www.atitech.com.





ATI 3D Xpression: We have found that DirectX will change this card to the ATI Graphics Pro Turbo.  You will need to change your card back to its original driver for Outlaws to run.  See the directions above to change your driver. ATI’s web address is http://www.atitech.com.





ATI 3D Xpression+ PC2TV: We have found that DirectX will change this card to the ATI Graphics Pro Turbo.  You will need to change your card back to its original driver for Outlaws to run.  See the directions above to change your driver. ATI’s web address is http://www.atitech.com or http://www.atitech.ca.





Creative Labs 3D Blaster: When your video driver is set to 512x384, your monitor may lose its signal, but the game will continue.  Creative is aware of this problem.  There may be a fix for it on their website at this time. Creative’s web address is http://www.creaf.com.





Diamond Multimedia Edge 3D: DirectX does not support this card because it does not currently have Windows 95 compatible drivers.  You can contact your hardware manufacturer or Diamond Multimedia for updated DirectX drivers. Diamond’s web address is http://www.diamondmm.com.





Diamond Multimedia Viper: DirectX does not support this card because it does not currently have Windows 95 compatible drivers. You can contact your hardware manufacturer or Diamond Multimedia for updated DirectX drivers. Diamond’s web address is http://www.diamondmm.com.





Diamond Stealth 64 Video VRAM: Use the Diamond GT driver version 4.02.365. Earlier versions were not DirectX compatible. Diamond’s web address is http://www.diamondmm.com.





Diamond Multimedia Stealth 3D 2000: Setting the card to its chipset works fine. (S3ViRGE). To change the chipset, follow the directions above. 





Early versions of Diamond GT drivers: When installing DirectX applications, a dialog box may appear asking if you would like to install a certified DirectX driver.  You should select "No," so that the Diamond GT drivers will not be overwritten. If you have already let DirectX change the drivers, follow the directions above to change back to the correct drivers.  Version 4.02.365 is available on their website and should be DirectX compatible. Diamond’s web address is http://www.diamondmm.com.





Number Nine #9GXE64: When you hit ALT-ESC in low resolution, you may go to a black screen with blue vertical lines & multicolor dots.  ALT-TAB back to the game and it should work fine. 





Number Nine 9FX Motion 771: The stock drivers are not DirectX 3.0a supported.  Setting the card to its chipset works fine (S3 Vision968). To change to the chipset, follow the directions listed above.





Number Nine Imagine 128: The shipped drivers have no DirectX support.  Use Windows 95 drivers, then reinstall DirectX 3.0a.  The only problem will be when the desktop is set to 256 and you are playing in low resolution the game is not full screen.





Orchid Kelvin EZ: You may experience a low frame rate when playing Outlaws at 640x480. Switching to a lower resolution should correct this.





S3 ViRGE: Use the driver that is provided to you by DirectX and not the driver that is shipped with the Virge chipset.





STB Powergraph 64: The stock drivers are not DirectX 3.0a supported.  Downloading the updated drivers (version 4.02.00.0095) from STB’s website should correct this. Their web address is http://www.stb.com.





STB Powergraph 64 Video: Setting the card to its chipset works fine. (S3Trio 64+) To change to the chipset, follow the directions listed above.





STB Sprint 32: Setting the card to its chipset works fine. (Trident 9440) To change to the chipset, follow the directions listed above.





STB Velocity 64V: The newest downloaded drivers are not DirectX 3.0a supported.  Setting the card to its chipset works fine (S3 Vision968). To change to the chipset, follow the directions listed above.





Sound Issues





DirectX compatibility


Consult the DirectX section of this Troubleshooting Guide for information about how to check to see if your sound card is DirectX compatible.  If it is not, check with your hardware manufacturer for updated drivers.





Volume Levels in Outlaws


If you find that the music levels are too loud or too quiet, and are unable to change the volume through the Outlaws volume configuration screen, then you may adjust these levels using the Windows Volume Control icon.  Use the ALT + TAB keys to go to the desktop, then double-click on the speaker icon in the corner of the taskbar.  





Note: If the Volume Control or the Media Player are not installed, some of the following instructions will not work.  If you want to add either of them, please consult the Windows 95 Helpfile for assistance.  Just type Volume Control or Media Player in the index section and follow the directions provided by Windows 95. 





Powered or Amplified Speakers


If you have powered speakers and have both line-out and speaker-out jacks on your sound card, try plugging your speakers into the line-out jack.  Most sound card’s speaker-out jack have an amplified signal and may cause static or popping on your amplified speakers.  Switching to your line out jack may greatly improve the sound quality.





General Sound Card Troubleshooting


If your sound card is not set up correctly in Windows 95, not 100% DirectX or Windows 95 compatible, or you have a resource conflict, these sound problems may occur:


You may hear static.


You may hear stuttering, especially as someone starts speaking.


There may be no sound.


The sound may drop out.


You may experience a clicking or crackling sound.


The game may not run.





�
Getting your Sound Working in Outlaws:


First make sure that your sound card is set up correctly in Windows 95. Then use the Windows 95 Media Player to test a sound. To do this:


Click on the START button on your taskbar.


Choose Programs.


Choose Accessories.


Choose Multimedia.


Choose Media Player.


Go to the File menu.


Choose Open... and choose a sound to test.  Please be sure to choose Files of type:  Sound (*.wav).





Wave Settings


Make sure that the wave setting is turned ON.  To do this:


Double-click on the Volume Control icon on your taskbar.


Turn the wave setting ON by de-selecting the MUTE box or turning up the volume in the wave setting. 





Volume Control


If you do not have the Volume Control icon on your taskbar:


Click on the START button on your taskbar.


Choose Programs.


Choose Accessories.


Choose Multimedia.


Choose Volume Control.


Turn the wave setting ON by de-selecting the MUTE box or turning up the volume in the wave setting.





Other Volume Control Programs


Other manufacturers may also have proprietary software that must be set separately from the Windows 95 Volume Control program. Please see your hardware manuals for more information.








Specific Sound Cards





Aztech Sound Galaxy Washington 16: You may experience occasional bursts of static while you are playing Outlaws. Please download the newest drivers from Aztech.  This may fix the problem. Aztech’s web address is http://www.aztechca.com.





Creative Labs AWE 64: If you are using driver version 4.33.12, Outlaws may crash as soon as you try to start the game with a Fatal OE error in VxD DSound. Driver version 4.33.14 corrects this and is currently available on Creative Lab’s website. Creative’s web address is http://www.creaf.com.





Early Ensoniq cards: If the game locks up, you are probably using a driver that is not supported by DirectX. Version W95b44 of the driver should correct this problem. Ensoniq’s web address is http://www.ensoniq.com.





Gravis PnP: When using the newest downloaded drivers, the game had numerous speedup zones in the cutscenes, but gameplay was fine. DirectX setup displays a blank line for the audio driver, which means that the driver has not yet gone through DirectX certification. Gravis’ web address is http://www.gravis.com.





If you are unable to resolve sound problems through this troubleshooting guide, please contact your hardware manufacturer for updated DirectX drivers.








Controller Devices





Keyboard Issues


Users of compact keyboards, such as those found on laptop systems or those used for ergonomic reasons, may experience some problems using the default set of keyboard commands. If you are using one of these keyboards, you may want to use one of the alternative sets of keyboard commands, or use the custom keyboard configuration to create a set of keyboard commands that works best with your keyboard.





Some keyboards may have limitations in the game, such as:


You may be unable to cycle through all of the weapons in your inventory while you are in a crouching position.  If you stand up, then crouch again, it should correct this problem.


You may be unable to use multiple keys at once. 


Occasionally keys may lock up, especially if held down for a long period of time.





Key Functions


A list of the default key functions is provided in the reference card.  You may change the function of many of these keys by using the custom configuration menu.  To access this menu:


Select Options from the game’s menu.


Select Keyboard.  


From this screen you will be able to assign new functions to the keys.  Once you have finished, click on the Accept button to save your changes.


Make sure that you only assign one function to each of the keys on your keyboard, mouse button, or joystick button; doing otherwise may cause problems in the game.





Mouse Issues


We have found through testing that the following may happen when you are playing Outlaws using a mouse:


Mouse control will not work while playing Outlaws in a window.


Your mouse button may lock in firing mode when you have held it down for a prolonged period of time.





Joystick Issues


Each joystick will feature various default functions when used with the game. The functions may differ slightly, based on the type of joystick being used.  To view the default functions for your joystick, consult the options menu.  To access this menu:


Select Options from the game’s menu.


Select Joystick.  


From this screen you will be able to view the current functions of the joystick, and/or change the function of the various buttons on your joystick. Once you have finished, click on the Accept button to save your changes.


Make sure that you only assign one function to each of the buttons, and a different direction to each Axis, otherwise you may cause problems with the game.





Calibrating Your Joystick


We recommend that you calibrate your joystick before playing Outlaws.  You can do this by going to the Joystick Control Panel in Windows 95.





Joystick Calibration    


If you experience any problems when using a joystick, you should make sure that your joystick is properly calibrated.  To do this:


Select Options from the game’s menu.


Select Joystick.  


Select Calibrate.


Once you have finished the calibration process, Outlaws will be minimized on your taskbar.  To return to the game, click on the Outlaws button on your taskbar.  


Some computers will crash the game if you calibrate the joystick during the game.  We recommend that you calibrate your joystick before playing Outlaws.





Joystick Control


When using certain types of joysticks you may encounter the following control problems:


If you set your hat switch to be used as your strafe buttons you may encounter problems when pushing the joystick all the way forward. The strafe buttons may not work.


You may not be able to customize all the buttons.


You may not be able to use the keyboard or mouse at all. In this case you will need to use the joystick for all game and menu functions.


You may encounter poor aiming control.


You may not be able to get your joystick to go completely to the left, right, top or bottom.


Your cursor may drift off the screen.


Your button may get stuck in firing mode.


You may have to re-calibrate your joystick.  Depending on the type of joystick you have, you may need to adjust your X and Y axis sliders during calibration to get it to calibrate correctly.  





Configuring Unassigned Buttons


If some of your buttons don’t work in Outlaws:


You may not have assigned them in Joystick Configuration.


You may not have installed the Windows 95 software for your joystick.  First try the Windows 95 software that came with your joystick.  You may also want to contact the manufacturer of your joystick for the newest drivers.





If You are Having Trouble with Your Gamepad


You may need to enable it in Joystick Configuration.


Press ESC.


Click on Joystick.


Click on the check box next to Gamepad to select this option.


Click on Accept to save your changes.





Unplugging Your Joystick


Don't unplug your joystick while playing.  But why would you do that, anyway?  If you wish to disable your joystick, there is a check box in the Joystick Configuration Screen to disable your joystick.  Just deselect the Active button, then click on Accept to save your changes.





Information on Specific Joysticks





CH Flightstick Pro:


We recommend that you do not use a button for persistent functions such as crouching.





�
Gravis Grip:


The software for the Grip replaces the Windows 95 joystick calibration utility with its own version.  When this happens, Outlaws cannot bring up the calibration screen when you try to access it through the game.





Microsoft Sidewinder 3D Pro


On some computers, the Microsoft Sidewinder 3D Pro may need to be setup as a 2 axis/4 button joystick in the Joystick Control Panel. Remember to switch the switch at the base of the stick to the single button.
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